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Hello and a warm welcome to Melodyne!

Many thanks for purchasing Melodyne and welcome to the program. Melodyne
offers a new, musical and intuitive way of working with audio data that we’re
confident you’ll enjoy. This user manual explains the individual functions of
Melodyne as well as the underlying concept. Please take the time to read it
through carefully.

You will find the latest news, interesting tips and tricks and useful FAQs on our
web site, www.celemony.com along with background reports from the development
department, tutorials and practical examples. It's well worth a visit!

Our software is constantly being further developed and improved. Please always
make sure that you are working with the latest version of Melodyne. (The
„Updates“ function in the „Help“ menu checks via Internet to see whether or not
a later version exists). You can always find the latest version in the myCelemony
area of our website: www.celemony.com/mycelemony.

If you have any questions concerning Melodyne, first please read the
relevant pages in this handbook and consult our FAQ pages to see whether
we’ve already answered the same question there: www.celemony.com/faq.
If any questions remain, please contact support@celemony.com and we will be
happy to help you further.

We hope you enjoy working with Melodyne!
All at Celemony
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What is Melodyne?

By and large, Melodyne behaves like an audio sequencer or digital audio
workstation (DAW): you record audio files or load them from the hard disk, arrange
them into tracks, edit them, save the edited project to your hard disk and can then
export individual edited tracks or the main L/R mix of the entire arrangement in
the form of an audio file to your hard disk.

But despite these superficial similarities, Melodyne is very different from such
applications, the reason being this: Melodyne analyses the audio files you record
or load in order to identify key aspects of their musical content. In other words,
instead of simply displaying the audio data in an editing window like conventional
sequencer or editor, Melodyne actually investigates the musical significance of
that data. The upshot, in the case of monophonic audio material, is that Melodyne
is capable of recognizing the notes that have been played or sung, pinpointing the
beginning and end of each note, classifying the nature of the transitions between
individual notes, assessing the rhythmic relationship between notes, and much
else besides: to Melodyne, a vocal track is not simply a succession of digital
sampling values but real music, the aspects of which it recognizes, is capable of
quantifying and — if the word isn’t too fanciful — can be said to understand.

A unique process of analysis and the program’s consequent ability to appreciate
the musical aspects of the material form the foundation upon which an elaborate
structure of editing functions (themselves unique) has been erected. You can, for
example, correct the pitch of out-of-tune notes — whether sung or played — with
a single mouse-click; transpose a melody or instrumental solo into a different key
or register without depriving it of its natural sound character; copy the melody —
and only the melody — of one audio recording to another; increase the intensity of
the vibrato applied to individual syllables, whilst removing altogether any
unwanted wavering of pitch; adjust the volume of individual notes; increase the
playback speed of the recording (without altering the pitch) or reduce it to a
standstill, if you like; lengthen individual notes to give them their correct note
values or alter the tempo of entire passages; refashion creatively the rhythmic
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pattern of recordings and exploit a wealth of possibilities that go way beyond mere
slicing for the creation of new loops With Melodyne Studio, it is even possible to
edit polyphonic material in an extraordinarily flexible and fascinating way. You can
do all this and more with Melodyne — quickly, easily, in a way that imposes
astonishingly modest demands on the resources of your system and (most
importantly) achieve results for the unique sound quality of which Melodyne is
world famous. 

This introduction is designed to give you the basic information needed for working
with the program. You will find more detailed and continually updated information
(should you require it) on our web site: www.celemony.com. Please bear in mind,
however, that some of the functions described (such as the time-stretching of
polyphonic audio material) are only available with the studio edition. Here are the
main points of difference between the two programs:

Melodyne cre8 studio
Tracks 8 unlimited
Max resolution 24 bits / 96 kHz 32-bit / 192 kHz
Stereo yes (new) yes
Stretching for polyphonic material no yes

Tip: for your first experiments with Melodyne, we recommend the interactive
‘Experience Tour’, which you can open from the program’s Help menu. In the
Experience Tour, we give you a quick roundup of the most important of Melodyne’s
functions. It’s interactive, too, so you can participate and try everything out for
yourself.

To help you hit the ground running, Melodyne comes with an integrated reverb
effect and a small but pleasant sounding software synthesizer called Podolski with
which you can try out the Audio-to-MIDI functions of Melodyne straight away
without further installation. Podolski was kindly provided by Urs Heckmann
(www.u-he.com). Other synthesizers and effects can be used as well, of course.

Please read this introduction through at least once to familiarize yourself with
Melodyne; it would be decidedly annoying (would it not?) to realize too late, when
the production was already in the can, that there was an easier or better way of
doing something than the one you used, and that you could have obtained better
results with far less effort had you known about it.

What is Melodyne?
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Try whatever comes to mind; experiment as much as you like; no harm can come
of it: Melodyne has a multi-level Undo function that allows you to backtrack if the
changes you make don’t turn out the way you want. Besides which, none of the
changes made in the course of editing has the slightest impact upon the original
file on your hard disk.

We begin this Introduction with some quick tips on Installation before getting
down to the nitty-gritty: the key functions of the program.

We hope you will enjoy working with Melodyne and that it will help you to attain
your musical objectives.
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01 Installation and activation

01-01 Installation
To install Melodyne, launch the installation program, which either you will find on
your Melodyne CD or you will have downloaded from the Celemony web site (it
may be necessary to unpack the installation program with a double-click). Simply
follow the onscreen instructions for the installation. Once the installation program
has stored the files on the hard disk, you can launch Melodyne with a double-
click. 

The Melodyne installation program offers you a number of options because
Melodyne works with various different plug-in interfaces. Not all the possible
components form part of the standard installation. In addition to Melodyne itself
and ReWire support, the Melodyne Bridge plug-ins for the VST, RTAS and AU
interfaces (the last-named only on the Mac) form part of the standard installation.
Support for DXi (PC only) does not form part of the standard installation; please
activate this option by hand if you need it. 

Prior to the installation, the installation program checks to see what components
are already installed. You could, for example, install Melodyne on its own and run
it at first without plug-in support. The desired plug-ins or other options can be
added in the course of a second installation without damaging the original
installation or the activation.

Under Windows, a de-installation program is available, which you can use to
uninstall the components you do not need. To do this, proceed as follows:
1. from the Start menu, open the Control Panel;
2. double-click on "Add or Remove Programs";
3. from the list of installed programs, choose Melodyne and click "Remove".

For further information about installation and the files that are stored in the
course of it, consult our FAQ at www.celemony.com/faq.

Note: Melodyne is continuously being improved. During online activation, a check
is made to see whether a later version is available than the version installed.
Afterwards, please check from time to time to see whether a newer version is
available than the one currently installed on your computer. One easy way to do
this is by choosing "Check for Updates" in the Help menu. Alternatively, you can
do this by visiting www.celemony.com/mycelemony. Via Melodyne's Help menu or
the Celemony web site, you can also contact Support or consult our FAQ. If the
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The Separate Selected Notes to Beats command
This command in the Edit Note Separations sub-menu of the Edit menu separates
the selected notes in equal notes; the size of the notes is entered using the
current grid setting (top right of the window).

The Separate Selected Notes to Beats command

04-06 The Revert and Revert and reset Position
commands

These two commands in the Revert to Audio files sub-menu of the Edit menu are
used to undo all editing of pitch, formants, amplitude etc. of a segment, restoring
it in other words to its original (unedited) state.

Whilst the first of the two commands does not restore the segment to its original
position in the arrangement (in the event that this has been changed), the second
returns the segment to the exact position in which it was originally recorded (or
else the position defined as its original position in the MDD file). In this way, if
you wish, you can restore the original time relationship with other recorded tracks.
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05 Other editing functions 
and options

05-01 The Melody Manager
The Melody Manager is a file browser optimized for audio files. It allows you to
navigate swiftly through your library and is at the same time a very useful
arranging tool. Unlike the standard Open File dialog, the Melody Manager is
capable of displaying the musical contents of your audio files, allowing you to
audition and select parts of individual files and drag them to the desired position
in your arrangement. Open the Melody Manager from the File menu.
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At the top left, you will see all the hard disks, partitions and CDs that are
available. When you click on one of them, in the next column to the right, you will
see the audio files or sub folders, through which you can then navigate further.
The lower area on the left is where you store your Favorites by dragging them from
the tree on the right. This will allow you to access them more rapidly.

The audio files in a folder are represented by a Play button. When you click on
this, you can listen to the file. You can also see the contents of the file, dragging
the edges of the window, if need be, so that you can see more of it. Using the
second list box from the right, you can select between various display modes for
the audio files. You can display

only the title

only the waveform

only the notes

the notes and the waveform

Melodyne blobs

If an audio file has not yet been analyzed, only the waveform can be displayed.
Whatever display mode you have selected, as the file plays back, a pointer
indicates the playback position. You can select parts of the melody with the
mouse. When notes are displayed, your selection is always set on the note borders,
and you will also hear exactly the notes selected. For easy arranging, you can drag
selections or even the entire melody into your Melodyne arrangement, with or
without tempo adjustment (depending upon whether or not Autostretch is
activated) and scale adjustment, when the Scale Snap function is activated.



To play back the current audio file, either click the play button beside its name or
double click (Stop with a single click) anywhere in the display. When you use a
double click, playback begins from where you clicked, unless you have made a
selection, in which case playback will start from the beginning of the selection
provided you double click somewhere within it.

The next list box is used to select the playback mode. ‘Plain’ plays only the
currently active audio file. ‘Cycle’ causes the selected audio file to loop, which is
useful if you want to hear how a drum loop sounds when looped. ‘Sequence’ plays
back all the audio files in the current folder in sequence. Note the volume control
to the right of the list box.

The Path drop-down menu in the top left allows you to return quickly to a
particular folder in the current tree. The Action drop-down offers a selection of
commands relating to the currently selected file. These are:

– Open in New Arrangement (works like the Open command in the Main menu)
– Add to the Current Arrangement (adds the selected file to a new track in the

current arrangement at position ‘O’ without tempo adjustment — works like
‘Import audio file’ in the main menu)

– Open in the MDD editor (use this to edit the results of the analysis if this is
necessary)

– Update MDD file (if it was created with an older version of Melodyne)
– Batch Detection (triggers the analysis of the entire folder including any sub-

folders)
– Rescan Directory (causes Melody Manager to update its display of the file

structure in the light of changes made using Finder/Explorer)
– Unregister Archives (relates to the use of Liquid Sound banks - see below)
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Working with the “Melodyne Sound Library” and
Ueberschall “Liquid” sound banks
With Melodyne cre8/studio, you can integrate titles from the Melodyne Sound
Library (MSL) as well as Liquid sound banks from Ueberschall into your work.
These libraries offer you high-quality phrases tailor-made for use with Melodyne;
they are extremely flexible and easy to manipulate, and you can insert them into
your own arrangements.

First copy the library files from the CD/DVD to your hard disk. The procedure for
activating MSL tiles and Liquid sound banks is described in Chapter 1.

Once you have activated a Melodyne Sound Library or a Liquid sound bank,
double-clicking on its entry on the status page of the activation assistant has one
of two possible effects:

- if Melodyne does not know where the sound bank is stored, a file select box will
open allowing you to locate it;

- if Melodyne does already know the location of the sound bank, double-clicking
opens the Melody Manager window through which you can access the samples in
the sound bank.

From the Melody Manager window, you can work with the material in the normal
way, dragging phrases, segments or even individual notes into your arrangements.

Note: certain Melodyne Sound Library titles also offer multi-voice material such as
vocal or wind ensembles. The multiple voices here are achieved through the
combination of individual ones, so you retain access at all times to the harmonies

A sound bank in the Melody Manager
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and their course. In the Melody Manager, you will find the samples for such
ensembles in sub-folders. You will also always find there an arrangement that you
can audition directly in the Melody Manager as though it were a sample, in order
to hear all the voices in context and with it the entire ensemble. You can only at
that time import the contained samples individually – either by selecting them in
the Melody Manager and dragging them one by one into your arrangement or by
loading the audition arrangement parallel to your own and copying the samples
from one arrangement to the other.

Files from a Melodyne Sound Library or Liquid sound bank are marked in the
Audio window and cannot be moved or copied into the audio file folder of an
arrangement. If you wish to transfer an arrangement that uses files from a
Melodyne Sound Library or Liquid sound bank to another computer, the relevant
library or sound bank must also be available and activated there (though it does
not matter where on the second computer the requisite library file is stored).

Arrangements in the Melody Manager
The Melody Manager displays not only samples but also Melodyne arrangements.
An arrangement is represented by a miniaturized image of the Arrangement
window and Mixer.   Using the Playback switch, you can now audition (i.e. listen
to without loading) arrangements along with all the tracks they contain just as
though they were samples. A double-click on the title bar opens the selected
arrangement in Melodyne. When you are looking for sounds, this new option allows
you to audition a number of arrangements swiftly and easily, loading the ones that
interest you, and copying the sounds you want into the current arrangement.

05 Other editing functions and options
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A Melodyne arrangement in
the Melody Manager

05-02 Compound notes
A useful aid when editing and handling notes is the ability to form a succession of
single notes into a compound note. This is particularly useful with ornaments as
well as notes created using the commands Separate Note as Trill or Separate Note
as Slide in the Edit > Edit Note Separations submenu. The advantage is that you



can perform the same action on all of the notes of which a compound note
consists simultaneously. If later you need to edit the notes singly, simply deselect
the Use Compound Notes option (rather than de-compounding the note itself).

These notes, which were created using the Separate Note as Trill command, have been formed into
a compound note to facilitate editing, but you can still access the notes individually.

Important: Please note that only adjacent notes (such as those in the example
above) can be fused to form a compound note. 

Compound notes are displayed in the notation as a single note, running from the
beginning of the first of the notes of which it is composed to the end of the last.
The pitch displayed is that of the note defined as the compound main note.
Editing functions always affect all the notes of which the compound note is
composed.

The options relating to compound notes are to be found in the Edit Note
Separations submenu of the Edit menu. To enter compound mode, check the
option Use Compound Notes in this submenu; it is only in compound mode that
compound notes are displayed and treated as such, in which case:
– only the compound note, not the individual notes of which it composed, is

displayed in the staff (or ‘score’) beneath the Bar/Time ruler;

– selecting any of the individual notes of which the compound note is composed is
equivalent to selecting all of them;

– when stepping through the audio data using the Left and Right arrows, selecting
the compound note triggers the playback of the entire group of notes of which it
is composed.

The second command Compound / De-Compound Notes is used to create a
compound note from a succession of selected notes or undo such an action
subsequently. There is no limit to the number of compound notes that can be
created.
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The command Set Compound Main Note determines the pitch assigned to a
compound note, which is not necessarily that of the longest note of which it is
composed. If to wish to designate some other note as the main compound note, you
need first to select it individually, which is not easily done if Use Compound Notes
is checked, since selecting any one of the notes of which a compound note is
composed will select the entire group. There are two ways to get round this: either
by rubber-banding the note you wish to designate as the compound main note or by
unchecking Use Compound Notes and then selecting it in the normal way.

The command Show Compound Main Note limits the selection to the main note of
a compound note. 

With certain tools, because they are concerned with the definition of individual
notes, it would make no sense for all the constituents of a compound note to be
selected automatically whenever the compound note was selected, so compound
mode is temporarily disabled when such tools (which include the tools for note
separation and pitch definition) are active. When editing pitch in the Editor, on
the other hand, compound mode remains active.

05-03 The Analysis of audio by Melodyne
As we said at the outset, for Melodyne to be able to render audio malleable and
offer such powerful editing functions, it must first analyze and interpret the file
loaded or recorded. This process, which is called ‘detection’, is usually carried out
automatically and results in the creation of a file containing the results of the
analysis and having the same filename as the original but with an additional
suffix: “.mdd’.

Detection is a complex process through which Melodyne obtains all kinds of
information about the file under analysis, including its tempo, the positions at
which each note or drum stroke begins and ends, and in the case of one-part
material, the pitch of each note as well as the prevailing tonality and mode (i.e.
the key).

Based on the information thus obtained, Melodyne takes a number of key
decisions, the most important being whether to treat the material as ‘melodic’ (i.e.
containing only one part), homo- or ‘polyphonic’ (i.e. containing two or more parts,
regardless of whether or not these are rhythmically independent) or ‘percussive’
(i.e. consisting primarily of unpitched material). This decision determines how the
blobs will be displayed in the Arrange window and Editor as well as how the

05 Other editing functions and options
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material will be played back using Melodyne’s Local Sound Synthesis (LSS).
Unless the material is melodic, for example, there is no point in displaying a pitch
curve. Whether the material is characterized as melodic or percussive also
determines whether the frequency is taken into account in determining where one
sonic event ends and the next begins or only the amplitude, how transients should
be handled during playback and whether or not the pitch of the blobs should be
displayed in the staff.

In short, the conclusions drawn by Melodyne in the course of the analysis play an
important role in determining how your audio material is presented and which
functions are and not available when you come to edit it; and although the process
is fully automatic, you can if you wish intervene in various ways on the rare
occasions where the material is such that optimal results cannot be obtained
without such intervention. These include:

– The ability to change the default parameters governing the analysis and trigger
the process manually (as was the standard procedure with earlier version of the
program); you might wish to do this if the material is in some way intractable or
if you are batch-processing a whole set of recordings of the same singer and
want to ensure consistent results. The parameters in question are accessed from
the ‘Detection’ page of the ‘Preferences’ dialog, where you are also offered the
option of saving the newly modified parameter set for later use. The significance
of each of the individual parameters will be explained later in this section.

– Using the Definition menu, you can also force Melodyne to adopt a particular
interpretation or treat the material differently – as melodic, for example, rather
than percussive – and trigger a fresh analysis based upon the new parameters.
You have full control, in other words, over the way Melodyne displays and
handles your audio material.

– Melodyne’s automatic detection copes with very diverse material and works as a
rule very reliably without requiring any intervention by the user. Occasionally,
however, there is material with which Melodyne interprets individual notes an
octave too high or too low. As soon as you edit such a falsely detected note in
the Editor, unwanted sonic artifacts can appear. For this reason, Melodyne offers
a Correction Mode in which you can correct the automatic detection if necessary.
You reach this mode from the Editor of Melodyne, to which you return
seamlessly after a successful correction; thereafter no further artifacts appear.
You will learn more about this Correction Mode further down.
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– Melodyne allows you not only to correct possible discrepancies in the detection
but also to edit in a detailed and diverse way Melodyne’s detection results.
(Remember: the file created by Melodyne with the detection results has the file
ending “*.mdd”). This editing takes place in the MDD Editor and is as a rule not
necessary in everyday work with Melodyne. It is, however, of importance if you
wish to perfect a file for repeated use in Melodyne, for example for the building
of a sample library optimized for Melodyne. Then, in addition to the possible
correction of detection errors, it will also be of interest to examine the rhythmic
interpretation of the material and the detected scale. For such tasks, which have
nothing to do with the arrangement currently being edited but with the audio file
itself (or to be more precise: its MDD file), Melodyne provides the MDD Editor,
to which a separate chapter is devoted 

As well as being able to influence manually the otherwise automatic process of
analysis, correct detection errors in the Correction mode offered by the normal
editor, and edit and perfect an audio file using the more powerful functions of the
MDD editor, which is independent of the current arrangement, you can select for
each separate segment whether or not Melodyne’s Local Sound Synthesis should
control the playback of the audio material and, if so, whether the algorithm for
melodic material or that for polyphonic and percussive material should be
employed – of which, more later. 

The introduction over, we would like to go into each of these areas in greater
detail, beginning with the detection parameters.

Detection parameters
Melodyne 3 adapts automatically to the material at hand: there is generally no
need to modify any of the defaults; simply load the file and Melodyne itself will
decide whether it is melodic or polyphonic/percussive and act accordingly. It may
be, however, that in certain situations (for example, when batch-processing
multiple recordings by the same singer) more consistent results can be obtained
through the use of detection templates, which you can create, save and reload for
subsequent use. This involves overriding the default, Auto-detect, and entering,
storing and reloading new parameters.

05 Other editing functions and options
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The Detection parameters in the
Preferences dialog

To create a new parameter set, select Add from the Options list box at the top
right of the dialog. A window opens offering various options, which become the
currently selected options as soon as you close the window. The following options
are available:

Highest Note / Lowest Note: this determines the range to which Melodyne will
confine its search for notes (fundamentals). If you know the highest and lowest
notes of a melody, entering them here obviates the risk of Melodyne confusing the
first harmonic with the fundamental or confusing a note with the note an octave
lower because (say) the singer had a frog in his throat at that instant, but, as
we’ve said, such errors are rare, so this is seldom necessary. If there is crosstalk
on the recording, such as the (faint) sound of the bass spilling into the flute
microphone, you can ensure that Melodyne concentrates on the flute and
disregards the grumbling of the bass in the background (and any stray squeaks) by
entering here the lowest and highest notes the flute is capable of producing.

Separation Sensitivity determines whether more or fewer segments of the audio
file are detected as separate notes. This parameter is also available after the
detection in Correction mode and in the MDD editor, allowing you to adjust the
note separation without having to re-detect the entire file.
Silence Note Limit: this determines the level beneath which the audio is deemed
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to be silent; if the threshold is so low that the audio level never falls below it (due
perhaps to the self-noise of the microphone), each note will be deemed to last
until the next note sounds, even where, to the listener, it may appear to have
ended, and no rests will appear in the score. This parameter can also be modified
in Correction mode (from the normal editor) as well as using the MDD editor and
allows you to adjust note boundaries without triggering a fresh analysis of the
entire file.

For tempo recognition, there are four options:

1. Automatic Detection (the default)
2. Given Tempo (you enter the tempo manually in the box provided)
3. From Name at Digit (in fact, Melodyne will take the tempo from the first string

of digits following n, so if the tempo is 160 BPM and the filename
“git_160_clean.wav”, you can just enter ‘1’. It is only where the first digit in
the filename relates to something other than the tempo (e.g.
“003_git_160_clean.wav”) that you need to tell Melodyne to skip the ‘003’
and begin reading at char 9.

4. From File Duration (the tempo is derived from the length of the file)

In the lower part of the window, there are a number of parameters which, whilst
they have no influence upon the process of analysis itself, do affect the way the
audio material is handled at the editing stage and during playback:

Notation: tonal / rhythmic. This determines whether the notes will all be displayed
on the same line in the score (like a snare drum part, for example) or like a normal
melody, where the position of each note depends upon its pitch. This parameter,
too, is accessible from the Definition menu, so you can change your selection after
the analysis is complete.

Portamento: Treat notes separately / Track portamento: In the course of its own
analysis of the audio data, Melodyne always takes account of any portamentos
(sliding from one note to another), but after dragging either or both notes to a
different pitch in the course of your own editing, you may feel that a portamento is
no longer appropriate. This parameter determines the global default: whether the
notes should in such cases be separated or the portamento retained, though you
can, of course, override it in individual cases using the Note Transitions tool in the
Editor.
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Play Algorithm: here, too, you are simply setting the default. The playback
algorithm can be changed at any time (the options are described below) without
requiring a fresh analysis of the audio file.

Separation: these options determine the basis upon which Melodyne decides
whether to interpret a sonic event as a single note or as two or more individual
notes. In the case of melodic material, a change of pitch is taken as indicative of
a change of note, but in the case of polyphonic and percussive material this is
largely ignored. Instead, the presence of a fresh attack is determinative.

Note that even if you leave the defaults unaltered in the Detection panel of the
Preferences dialog, the program will still behave differently from the way it
behaves when automatic detection is selected; for example, if under Separation
you select Percussive, Melodyne will observe the criteria chosen whether the
material is really percussive in nature or not.

Custom detection parameters should only be used in rare cases, such as when you
are processing a set of audio files of the same type for a sound library and know
exactly which settings are most appropriate. Under other circumstances, Melodyne
will almost certainly do a better job if left to its own devices. For this reason, if
any custom detection parameters are active when you next launch Melodyne, you
will be asked to confirm that you still wish to use them. This is to prevent you
carrying on for weeks using non-standard settings (and in all probability obtaining
inferior results) without realizing it.

Reset or repeat detection
The Definition menu allows you the option of resetting or repeating the detection
with fresh parameters, as well as offering a shortcut to the Detection page of the
Preferences dialog, the contents of which we have just been describing.
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Using the Reset Detection to … commands, you can tell Melodyne to treat a
recording as ‘melodic’, for example, when its own analysis of the material may
have concluded that it was ‘polyphonic’, or ‘rhythmic’ where its own analysis may
have concluded that it was ‘melodic’. As a result, Melodyne adopts a whole swathe
of different parameters or options — relating to things such as the type of note
separation, the type of notation, the interpretation of note transitions, the choice
of playback algorithm and the parameters thereof … — which is obviously far
faster than altering the same parameters or options manually one by one. The
Reset Detection to … commands are therefore macros that impose new settings
for the interpretation of the analysis results and the playback algorithm with a
definite purpose and in a single go.

The command Redetect Audio File triggers a fresh analysis of the material based
upon the current settings, the default being ‘automatic detection’. If, for example,
you wish to see what happens if you change one of the detection parameters,
select Detection > Select Definition > Select Detection Parameter Set, make the
desired changes, and select Definition > Redetect Audio File for them to take
effect.

NB: the commands in the Definition menu that we have just discussed are also
available from context menus in correction mode (see below) and the MDD editor.

Correcting the automatic detection
Melodyne’s analysis (or ‘detection’) of an audio file when it is first loaded is the
basis for all subsequent editing. It involves a determination as to whether the
material is tonal, polyphonic (Melodyne studio only) or percussive, as to where
each note ends and the next begins, and as to the pitch and amplitude of the
signal at any point in time. Usually, the results are highly accurate, but with
certain types of material, things can occasionally go wrong:

– It can happen that the fundamental does not sound with sufficient clarity,
causing Melodyne to mistake the first harmonic for the fundamental itself (with
the result that the note appears in the score as well as in the Editor an octave
higher than you expect); the exact opposite can also happen: you have a frog in
your throat, perhaps, and Melodyne thinks you were singing Middle C when you
thought you were singing the C an octave above. Errors of intervals other than an
octave, incidentally, are very rare.

– Sometimes notes are not cleanly separated – i.e. two notes appear as a single
note

05 Other editing functions and options

Melodyne cre8/studio user manual



– Melodyne sometimes confuses tonal material with rhythmic and vice versa: one
could think of certain passages of scat (jazz singers imitating instruments),
where different people could have a legitimate difference of opinion as to
whether it was tonal or rhythmic. The significance of the decision is this: when
material is interpreted as ‘rhythmic’: all the notes are displayed at the same
pitch; when it is transposed, the formants are also transposed; and no manual
editing of formants is possible.

Such errors can be corrected manually. For this purpose, Melodyne offers a special
edit mode, which you enter by checking the option Correct Detection in the
Definition menu and which causes the blobs to turn yellow and the pitch curve to
appear in bold red. 

The Editor in Correct
Detection mode

In Correct Detection mode, the mouse pointer is again context sensitive: when you
move it to the center of a blob, it becomes the Pitch Correction tool, though the
effect of dragging a note here to a new location is not to alter its pitch (as would
be the case in the normal Editor) but to trigger a fresh search at the new position;
it’s a hint, in other words; the equivalent of saying: “try looking here”. If Melodyne
is successful, the pitch curve will be redrawn to take account of the newly
detected note. If, however, the redrawn pitch curve seems implausible, by double-
clicking the blob, you can trigger a fresh search at the designated location.

In Correct Detection mode, the blobs do not necessarily move by an integral
number of semitones, and the results of your editing are stored in the *.mdd file
that accompanies the audio file, so your corrections are never lost; when the audio
file is next loaded, notes will be displayed at their corrected locations.
When you move the pointer to a position above or below (or to the beginning or
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end of) a note, it changes to the Note Separation tool, which you can use to split
(or move the boundaries between) notes as in the ordinary Editor. The difference
between this and altering the note separations in the normal editor is that here the
new separations go into the definition of the melody and are automatically stored
in the .mdd file, as soon as you leave the mode for the correction of the detection,
whilst the alteration of the separations in the normal Editor only relate to the
melody in the current arrangement.

The Emphasize Pitch and Consider Roughness options can 
now be accessed through check boxes

Check Emphasize Pitch at Dragged Note Position for Detection whenever you feel
that it is noise in the recording that is preventing Melodyne detecting a note you
yourself can hear at the pitch to which you have dragged the corresponding blob
and Consider Sound Roughness for Detection whenever Melodyne is placing blobs
an octave too low, as sometimes happens when the singer has a cold or a gravelly,
growling voice.

Note that these options only affect the detection of those notes that you drag or
double-click with the Correct Pitch tool in Correct Detection mode; they have no
affect upon the detection of other notes.

Increasing the value in the ‘Separation’ field in the Inspector area in Correct
Detection mode increases the likelihood (in cases of doubt) that Melodyne will
divide a sonic event into two or more notes rather than a single longer one.

The ‘Silence’ parameter (still in the Inspector area in Correct Detection mode)
determines the level beneath which the audio will be interpreted as silent; if the
threshold selected is very low, each note will be deemed to last until the next note
sounds, even where, to the listener, it may appear to have ended, and no rests will
appear in the score. This parameter also influences note separation but has
nothing to do with a noise gate or the ‘Strip Silence’ function offered by other
sequencers.
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From the drop-down list on the right of the
Inspector area, you can select whether the
note separation should be based upon the
assumption that the material is melodic,
percussive or polyphonic or else opt to
dispense with automatic note separation
altogether. Experiment with these options
if you are not satisfied with the results of
the automatically selected system of note
separation.

The next group of commands (the Reset Detection set), which can also be
accessed from the Definition menu, are useful if the detection errors go beyond
the incorrect positioning of note boundaries; if, for example, a recording
containing staccato pitched notes is wrongly interpreted as percussive, selecting
Reset Detection to Melodic Mode remedies the error. This and the similar
commands Reset Detection to Polyphonic Mode and Reset Detection to Percussive
Mode allow you to determine manually how Melodyne interprets the material and
influence the playback algorithm, the blob and note display, the type of note
separation and the pitch connections between the notes. 

The command Redetect Audio File triggers a fresh analysis of the material based
on the current parameters; if you wish to modify these beforehand, the command
Select Detection Parameter Set opens the Detection page of the Preferences
dialog so that you can make the necessary changes. These commands, too, are
also available from the Definition menu.

To leave Correct Detection mode, either uncheck the menu item Definition >
Correct Detection or select any tool from the Toolbar.

NB: When you correct the note separations in Correct Detection mode, your
corrections are stored in the *.mdd (analysis) file and will therefore be displayed
and acted upon when the audio file is next loaded. Secondly, you can only edit
note separations in Correct Detection mode if the audio file is ‘undamaged’, in the
sense that no copy and paste operations have been performed on it and no new
segments created.

The Definition menu
The Definition menu brings together those functions relating to editing the *.mdd
files of audio files. You can use this menu, for example, to activate Correction
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mode from the Editor, to access the Reset and Redetect commands (see the
description above) and open the MDD Editor in order to make far-reaching
changes to an MDD file. You will also find two new commands:

With “Save MDD from current Edit State” you can apply the current state of the
editing to the *.mdd file of the audio file, which saves you switching to Correction
Mode or opening the MDD Editor for small corrections. When this command is
used, the current state of the melody in the Editor (note separations and tempo
definition) is saved for the current audio file in its *.mdd file; alterations to the
pitch and formants settings, however, are ignored. This command can only be
used when the audio file in the Editor has not yet been broken into small pieces
and rearranged using the copy and paste functions or distorted in terms of time.

The ‘Apply Arrangement Tempo and Tone Scale to all MDDs’ command does what you
would expect and also makes these the standard settings for the audio files affected.

05-04 Melodyne’s playback algorithms
Local Sound Synthesis, a technology specially developed for Melodyne, makes it
possible to treat pitch and tempo as wholly separate entities. You can, for
example, bring the music to a halt without it falling silent as well as slowing down
or speeding up the tempo without this having any effect upon the pitch or even
creating unnatural artifacts. Furthermore, when notes are stretched or
compressed, they retain their essential character, by which I mean that the
starting transients that are characteristic of the instrument or singer in question
remain unmodified; the acceleration or slowing down of the material is performed
by stretching or compressing the sustain or 'steady state' phase of notes, and as a
result it really does sound as though the instrument or vocalist in question is
simply performing the same piece at a different tempo. Melodyne offers a number
of options and parameters that allow you to tailor Local Sound Synthesis to the
musical context. These are displayed in a separate pane above the toolbar when
you select View > Show Play Algorithm Parameters.

The parameters displayed relate to the selected segment (for more on segments,
see §03-09 The behavior of contiguous notes and note segments).

Plain or Processed: This determines whether or not processing is applied to the
sound during playback. When Melodyne completes its 'detection' of the audio
material, the parameter 'Processed' is selected. If, however, you only wish to edit
certain notes and would prefer the rest of the recording to be played back
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normally, you can divide the recording into a number of segments, selecting
'Processed' for those you have edited and 'Plain' for the rest. 

The parameters for Plain

When 'Plain' is selected, you have two further choices that become important if
you have altered the tempo: if you select 'Original', the tempo changes will be
ignored and the audio will play back exactly as recorded. If, on the other hand,
you select 'Sampler', the pitch of the playback becomes tempo-dependent, as is
the case with a sampler or a tape recorder when you alter the speed at which the
tape passes the playback head. With the 'Sampler' setting, variable pitch courses
within single notes also result from a variable time course in the notes. The time
course within the notes can be set with the Edit Time Handle tool in the Editor
(see Editor tools). This allows you to create interesting effects above all with
percussive material. 

The algorithm options in Melodyne studio
"Melodic" or "Poly/percussive": Melodic mode is the algorithm of choice for any
monophonic material, like vocals, all members of the woodwind and brass
families, solo guitar or bass lines, etc. Also speech ist best reproduced with the
Melodic mode. The voice's formants will be preserved on pitch changes and can
also be altered at will. 

Poly/Percussive mode is the algorithm of choice for any other material, such as
percussion, drums, noises, but also any sounds consisting of multiple voices, like
guitar or piano chords, polyphonic voicings, choirs, and up to full mixes of
arbitrary sources. The automatic detection will set this algorithm if it finds the
material to be either polyphonic or percussive, but will adjust the other parameters
(descibed below) slightly different depending upon the material being more
percussive or more polyphonic.

Please note that the initial setting is just the best guess the program makes. You
can always set the algorithm to different values if it fits the material better. For
example, if you have a funky slap bass line, this can be considered somewhere
half way between melodic and percussive, and if it is more important for your
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purpose to preserve a very clear attack on pitch changes, you would choose the
Poly/percussive mode.

Both Poly/Percussive mode and Melodic mode offer the following additional
options and parameters.

Crisp or Smooth: The terms 'Crisp' and 'Smooth' are used here to describe two
varieties of internal sound processing, the precise nature of which depends upon
whether Melodic or Poly/Percussive has been chosen. If in doubt, try both to see
which works best.

When the algorithm for melodic material has been selected, the option 'Crisp' is
usually the better choice, as it gives the sound greater presence and there is less
loss; besides which, it makes more modest demands upon the capacity of the
CPU, allowing you to play back a greater number of tracks simultaneously. There
are, however, cases in which the 'Smooth' algorithm delivers superior results;
these include cases where extreme stretching is applied to a sound as well as well
as those where there are sudden percussion-like changes or clicks within
individual notes; the tendency is for the 'Crisp' algorithm to render such
irregularities even more obtrusive, whereas the 'Smooth' algorithm applies a gentle
airbrush. 

When the algorithm for polyphonic or percussive material is selected: the 'Smooth'
setting delivers cleaner and smoother results with held polyphonic sounds, such
as sustained guitar chords; the 'Crisp' setting is more useful with staccato sounds
and gives percussive sounds greater incisiveness. If the analysis has revealed the
material to be polyphonic, this parameter is generally set to 'Smooth', whereas for
percussive material the 'Crisp' parameter is generally preferred.

The parameters for Poly/Percussive mode in Melodyne studio

Poly/Percussive mode also offers a parameter called 'Transients' that determines
the intensity of the attack phase of the notes in the audio file: move the slider to
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the left and the transients are less pronounced, making the sound softer; move the
slider to the right and the sound becomes more percussive. The standard setting
for material identified as percussive is all the way to the right, whilst for
polyphonic material it is in the center. 

If ever the algorithm for polyphonic material fails to deliver the expected results, it
is a good idea to begin by experimenting with this slider and checking the note
separations. With the other algorithms, the note separations and with them the
blobs represent only 'editing units' and are of practically no acoustic relevance.
However with the polyphonic algorithm, it is worth checking the note separations
if you want to transpose or stretch an entire file, as the separations determine how
the transients in the audio material will be handled. Add separations or move
existing ones to better preserve the transients; remove them if they lead to
unwanted 'muttering' during long sustained chords.

Melodyne studio's Polyphonic algorithm offers an option for the preservation or
editing of formants. This means you can modify the pitch of the formants of
individual notes using the Formant tool – just as you can with the Melodic
algorithm. The "Formant Tuning" parameter determines the way formants are
affected when the Polyphonic algorithm is used. With it, you can determine the
degree of formant correction (range: left to middle) as well as its sound and
character (range: middle to right). Or, to be more precise:

– if the slider is at the left-hand extreme, no formant correction takes place; i.e.
when the fundamentals are transposed, the formants are transposed along with
them. With the slider in this position, the load on the CPU is around 20% less
than when formant correction is activated;

– as the slider is moved to the right, for the first third of the way there is a
gradual increase in the degree of formant correction; the formants are no longer
transposed to the same extent as the fundamentals;

– the central third of the range serves primarily to adapt the sound to the
material. In the case of sensitive material – an a cappella quartet, for example –
the sound of the formant correction can be adjusted. The balance lies between
"too little formant correction" (further to the left) and the creation of "false
harmonic tones" (further to the right). As a rule of thumb, when the pitch of the
dominant voice is higher, the position of the slider is further to the left; at lower
pitches, the slider is somewhat further to the right;
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– the right-hand third of the slider range is reserved more for effects. Here
additional overtones are brought out. The effect could be anything from a slight
change in the character of a grand piano, for example, to the radical
transformation of a drum loop. A precondition for this is that a fairly strong
formant adjustment (and/or transposition) is also effective, for example with the
real-time parameters. Here, extreme intervention in the character of the sound is
possible.

In the case of newly detected polyphonic material, the "Formant Tuning" slider is
by default in the middle position; in other words, the formant correction function
is activated and set at a level that has been determined empirically to be suitable
for most material.

The parameters for Melodic mode

Formant Correction, 0% - 100%: When you alter the pitch of notes, this
parameter determines whether the formants should move en bloc with the
fundamental - in which case there is no formant correction (0%) - or whether the
formants should remain in place - in which case it is their relationship to the
(transposed) fundamental that is being 'corrected'. The standard setting is 100%,
which means that the formant frequencies remain unchanged regardless of the
pitch of the fundamental, as they do, for example, when you sing (or play on the
violin) a high note followed by a low one - or vice versa. Obviously, unless have
transposed at least one note of your audio file, the value assigned to this
parameter is irrelevant.

Transposing a note a fifth (say) with Formant Correction set to 0% is the same as
transposing it a fifth with Formant Correction set to 100% and then moving the
formants a fifth in the same direction, however in the former case, the formant bar
will be superimposed on the note, whilst in the latter case, it will be displayed
hovering a fifth above the note. In either case, dragging the bar upwards or
downwards by a given interval will result in the formants being moved by the same
interval from their current position.
Period, 1 - 6: The normal value for this parameter is "1". Other values result in the
algorithm behaving as though the recording had been detected with 2, 3… times
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the period (i.e. an octave, twelfth … deeper). This can improve the sound of
things like very high flute and string parts, particularly when elements of the
octave below are present, as is often the case when flutes are overblown or when a
vocalist has a particularly gravelly voice. It is worth experimenting with this
parameter when dealing with problematic material. If the aim is realism, however,
you are seldom going to need a value higher than "2" and even then, the Formant
Correction parameter should be set to 0%. Period values greater than 2, or greater
than 1 where formant correction is applied, lead to unnatural results and are only
useful for the creation of special effects. If only the tempo of the recording has
been altered and the Period parameter has been modified, the setting of the
Formant Correction slider is ignored.

The algorithm options offered by Melodyne cre8
"Melodic" or "Percussive": Melodic mode is the algorithm of choice for any
monophonic material, like vocals, all members of the woodwind and brass
families, solo guitar or bass lines, etc. Also speech ist best reproduced with the
Melodic mode. With Melodic mode, the voice's formants will be preserved on pitch
changes and can also be altered at will. 

Percussive mode is the algorithm of choice for any other material, such as
percussion or drums, but also for plucked sounds, which have a very sharp attack
followed by a rapid decay phase. With Percussive mode, the formants or sound
character will change if the sound is altered in pitch and cannot be adjusted
independently from the pitch. The automatic detection will set this algorithm if it
finds the material to be percussive. Polyphonic material, like chords or full mixes,
can only be processed with the algorithm provided in Melodyne studio.
Please note that the initial setting is just the best guess the program makes. You
can always set the algorithm to different values if it fits the material better. For
example, if you have a funky slap bass line, this can be considered somewhere
half way between melodic and percussive, and if it is more important for your
purpose to preserve a very clear attack on pitch changes, you would choose the
Percussive mode. Or, on the other hand, if it is more important to preserve the
formant on pitch changes, you would choose the Melodic mode.

97

05-04 Melodyne’s playback algorithms

Melodyne cre8/studio user manual



98

cre8's Percussive algorithm has no editable parameters

The parameters for Melodic mode

Crisp or Smooth: The terms 'Crisp' and 'Smooth' are used here to describe two
varieties of internal sound processing. If in doubt, try both to see which works
best. The option 'Crisp' is usually the better choice, as it gives the sound greater
presence and there is less loss; besides which, it makes more modest demands
upon the capacity of the CPU allowing you to play back a greater number of tracks
simultaneously. There are, however, cases in which the 'Smooth' algorithm delivers
superior results; these include cases where extreme stretching is applied to a
sound as well as well as those where there are sudden percussion-like changes or
clicks within individual notes; the tendency is for the 'Crisp' algorithm to render
such irregularities even more obtrusive, whereas the 'Smooth' algorithm applies a
gentle airbrush.

Formant Correction, 0% - 100%: When you alter the pitch of notes, this
parameter determines whether the formants should move en bloc with the
fundamental - in which case there is no formant correction (0%) - or whether the
formants should remain in place - in which case it is their relationship to the
(transposed) fundamental that is being 'corrected'. The standard setting is 100%,
which means that the formant frequencies remain unchanged regardless of the
pitch of the fundamental, as they do, for example, when you sing (or play on the
violin) a high note followed by a low one - or vice versa. Obviously, unless have
transposed at least one note of your audio file, the value assigned to this
parameter is irrelevant.

Transposing a note a fifth (say) with Formant Correction set to 0% is the same as
transposing it a fifth with Forman Correction set to 100% and then moving the
formants a fifth in the same direction, however in the former case, the formant bar
will be superimposed on the note, whilst in the latter case, it will be displayed
hovering a fifth above the note. In either case, dragging the bar upwards or
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downwards by a given interval will result in the formants being moved by the same
interval from their current position.

Period, 1 - 6: The normal value for this parameter is "1". Other values result in the
algorithm behaving as though the recording had been detected with 2, 3… times
the period (i.e. an octave, twelfth … deeper). This can improve the sound of
things like very high flute and string parts, particularly when elements of the
octave below are present, as is often the case when flutes are overblown or when a
vocalist has a particularly gravelly voice. It is worth experimenting with this
parameter when dealing with problematic material. If the aim is realism, however,
you are seldom going to need a value higher than "2" and even then, the Formant
Correction parameter should be set to 0%. Period values greater than 2, or greater
than 1 where formant correction is applied, lead to unnatural results and are only
useful for the creation of special effects. If only the tempo of the recording has
been altered and the Period parameter has been modified, the setting of the
Formant Correction slider is ignored.

05-05 Defining the Tone Scale and Tuning
In Melodyne, you can work with any scale or tuning you like. The scale defines
which tonal positions of a scale can be used. The tuning defines the exact pitch
that the different tonal positions have relative to each other. It also defines the
tuning pitch of the key note.

– Scales are used by Melodyne to define to which tonal snap-to positions notes
can be moved by the pitch change tool in the Editor Window when “Scale Snap”
is activated. 

– Tuning is used by Melodyne to define the exact pitch of the individual tonal
positions, if the intonation of notes is to be corrected. 

Scale and tuning are always defined for an entire arrangement. The panel to
define and edit the scale can be opened from the menu Windows ->Tone Scale. 
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The tone scale panel always first appears in the form in
which it is displayed in the picture to the left. For most
applications, the editing functions that are at your disposal
here will be sufficient. 

– To the left, you will find the buttons for the selection of
the key note of the scale, i. e the key - by clicking on a
button the key note for the arrangement is defined. With a
mouse click with the “Shift” key pressed you toggle
between major and minor modes. 

– To the right, you find text fields in which the frequency of
each key of the scale is displayed. Here, you can enter the
tuning of a reference note (in Hertz). All other fields will
change according to the tuning chosen in a text field.
Thus you cannot enter different frequencies for different
notes of the scale here - the chosen tuning sets the
relation between the tones. For example, if a piece has
been recorded in a tuning with A=415 Hz, you should
enter “415” into the text field defining A, and all other
frequencies will change
accordingly. 

– At the bottom there is a text field which is labeled
“Offset” - this field allows you to enter the deviation from
“standard” tuning (A=440 Hz) in cents. If you enter a
frequency in the note fields, this field will always also
show the deviation from standard pitch in cents. 

– At the top left of the Tone Scale window, there is a drop-
down list from which you can select from a large number
of different scale structures. These include not only the
harmonic and melodic ascending forms of the minor
mode but the church modes, major and minor
pentatonic, whole tone and diminished scales as well as
scale structures employed in the music of Asia and the
Middle East.
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